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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Introduction

Lorsque des textes sont utilisés dans des documents Draw, ils sont contenus dans des cadres. Ce 
chapitre décrit comment créer, formater, utiliser et supprimer des textes. Il traite également des 
différents types de texte qui peuvent être insérés dans des dessins. Enfin, il indique comment 
insérer certaines formes de texte particulières, comme des listes numérotées ou à puce, des 
tableaux, des champs et des hyperliens.

Utiliser l'outil Texte

Pour activer l'outil Texte, cliquez sur l'icône Texte , pour un texte horizontal, ou sur l'icône Texte

vertical , pour un texte vertical, de la barre d'outils Dessin.

Si l'icône Texte vertical n'est pas visible, activez l'option Afficher les éléments d'interface pour les 
écritures est-asiatiques située dans Outils > Options > Paramètres linguistiques > Langues. 
Faites un clic droit sur la barre d'outils Dessin, allez dans Boutons visibles et activez l'icône Texte
vertical pour que celle-ci apparaisse.

Une fois que vous avez activé l'outil Texte, la barre d'outils Formatage du texte (Figure 1) remplace
la barre d'outils Ligne et remplissage. Cliquez à l'emplacement où vous voulez positionner le texte 
et un petit cadre de texte apparaît, contenant uniquement le curseur.

Figure 1 : Barre d'outils Formatage de texte

Dès que le curseur apparaît, vous pouvez modifier la police, sa taille et d'autres attributs de texte 
avant même de commencer à saisir du texte. La barre d'état indique que vous êtes en mode 
Édition texte et la position du curseur dans le cadre (paragraphe, ligne, colonne), qui s'actualise au
fur et à mesure de votre saisie (Figure 2).

Figure 2 : Barre d'état lors de la saisie de texte

Notes

Lors de la saisie de texte dans un cadre, vous séparez les différents paragraphes en 
appuyant sur la touche Entrée. Vous séparez les différentes lignes d'un paragraphe 
en appuyant sur les touches Maj+Entrée. La position du curseur telle qu'elle apparaît
dans la barre d'état est établie selon ces définitions : les renvois à la ligne 
automatiques ne sont pas pris en compte.
Contrairement aux cadres de texte (ci-après), la largeur de la zone de texte est 
variable et le retour à la ligne non automatique.

Utiliser l'outil Texte 6



Pour terminer la saisie d'un texte, cliquez en dehors de son cadre ou sélectionnez un autre outil de
la barre d'outils Dessin. La barre d'outils Ligne et remplissage revient à la place de la barre d'outils 
Formatage de texte.

Utiliser les cadres de texte

Grâce aux cadres de texte, vous pouvez placer du texte à tout endroit de votre dessin : une 
légende pour une forme, une note explicative, un titre…

Créer un cadre de texte

1) Cliquez sur l'icône Texte  ou sur l'icône Texte vertical  de la barre d'outils Dessin.

2) Cliquez et faites glisser pour dessiner un cadre de texte dans le document. Le curseur de 
texte apparaît à l'intérieur et le cadre est matérialisé par une bordure hachurée qui indique 
que vous êtes en mode édition de texte (Figure 3). La largeur du cadre est fixe. La hauteur 
augmentera au fur et à mesure de la saisie du texte.

3) Saisissez ou copiez le texte dans le cadre. La barre d'état indique que vous êtes en mode 
Édition texte et la position du curseur dans le cadre (paragraphe, ligne, colonne).

4) Cliquez en-dehors du cadre pour le désélectionner.

Figure 3 : Cadre de texte en mode édition

Déplacer un cadre de texte
1) Cliquez juste à côté du cadre de texte (gauche, droite, haut, bas). Le cadre de texte est 

sélectionné : les poignées de sélection apparaissent sur la bordure hachurée.

2) Cliquez au-dessus de la bordure hachurée (mais pas sur une poignée de sélection) et 
faites glisser le cadre de texte jusqu'à sa nouvelle position. Une copie transparente du 
cadre vous permet de voir à quel endroit vous aller le déplacer (Figure 4). Vous pouvez voir
l'amplitude du déplacement dans la barre d'état.
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Figure 4 : Déplacer un cadre de texte

Redimensionner un cadre de texte
1) Cliquez juste à côté du cadre de texte (gauche, droite, haut, bas). Le cadre de texte est 

sélectionné : les poignées de sélection apparaissent sur la bordure hachurée.

2) Déplacez le curseur au-dessus d'une poignée de sélection. Le curseur change et devient le
symbole de redimensionnement d'objet (qui dépend de votre ordinateur).

3) Cliquez et faites glisser la poignée de sélection pour redimensionner le cadre de texte. Une
copie transparente du cadre vous permet de voir son nouvel aspect (Figure 5).

Figure 5 : Redimensionner un cadre de texte

Pour conserver les proportions d’un cadre de texte lors de son redimensionnement, maintenez la 
touche Maj enfoncée avant de cliquer-glisser. Prenez soin de relâcher le bouton de la souris avant 
la touche Maj.

Note

Par défaut, vous ne pouvez réduire la hauteur d'un cadre de texte en-dessous de la 
hauteur minimale pour que le texte entier apparaisse. Pour cette raison, il est 
possible que, si vous réduisez la largeur du cadre, sa hauteur augmente. Voir l'option
Adapter la hauteur au texte de la boîte de dialogue Position et taille.

Utiliser la boîte de dialogue Position et taille
Pour un contrôle plus précis de la taille et de la position du cadre de texte, vous pouvez utiliser la 
boîte de dialogue Position et taille (Figure 6).

Pour ceci, sélectionnez le cadre de texte, puis appuyez sur la touche F4, sélectionnez Format > 
Position et taille ou faites un clic droit et choisissez Position et taille dans le menu contextuel.
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Figure 6 : Boîte de dialogue Position et taille

Position
La position d'un cadre de texte est définie dans l'onglet Position et taille. Saisissez les 
coordonnées X et Y par rapport à un point de base. L'unité de mesure employée est celle 
choisie dans Outils > Options > LibreOffice Draw > Général.

L'emplacement par défaut du point de base se situe dans le coin supérieur gauche de la page. 
Vous pouvez changer temporairement de point de base en cliquant sur le point correspondant 
de la figure de droite, afin de faciliter le positionnement. Ce changement n'est valable que pour 
une seule utilisation et le point de base revient à son emplacement par défaut lors de la 
fermeture de la boîte de dialogue Position et taille.

Vous pouvez empêcher les changements accidentels de position en cochant l'option Position 
de la section Protéger.

Taille
La taille d'un cadre de texte est définie dans l'onglet Position et taille. Saisissez la largeur et la 
hauteur par rapport à un point de base. L'unité de mesure employée est celle choisie dans 
Outils > Options > LibreOffice Draw > Général. Pour conserver la proportion entre hauteur 
et largeur, cochez Proportionnel.

L'emplacement par défaut du point de base se situe dans le coin supérieur gauche du cadre. 
Vous pouvez changer temporairement de point de base en cliquant sur le point correspondant 
de la figure de droite, afin de faciliter le redimensionnement. Ce changement n'est valable que 
pour une seule utilisation et le point de base revient à son emplacement par défaut lors de la 
fermeture de la boîte de dialogue Position et taille.

Vous pouvez empêcher les modifications accidentelles de taille en cochant l'option Taille de la 
section Protéger.

Adapter la largeur au texte
Cochez cette option pour que la largeur du cadre de texte s'adapte automatiquement à son 
contenu. La largeur sera alors celle de la ligne de texte (texte séparé par les touches 
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Maj+Entrée ou Entrée) la plus longue. La largeur du cadre et l'option Proportionnel ne sont 
alors plus modifiables.

Si l'option n'est pas cochée, vous pouvez réduire la largeur du cadre en-dessous de celle de sa
ligne la plus longue : des retours à la ligne automatiques seront alors ajoutés.

Adapter la hauteur au texte
Cochez cette option (comportement par défaut) pour que la hauteur du cadre de texte s'adapte
automatiquement à son contenu. La hauteur sera alors la hauteur minimale pour que le texte 
entier soit visible. La hauteur du cadre et l'option Proportionnel ne sont alors plus modifiables.

Si l'option n'est pas cochée, vous pouvez réduire la hauteur du cadre en-dessous de celle 
minimale pour afficher toutes les lignes. Cependant, le texte entier sera toujours affiché et 
débordera de son cadre. C'est pourquoi il est recommandé de conserver cette option.

Le comportement d'un cadre de texte vis-à-vis des paramètres des onglets Rotation et Inclinaison 
et rayon d'angle est identique à celui des autres objets : voir Chapitre 3 (Manipuler les objets et les
points des objets).

Utiliser la boîte de dialogue Texte
Pour ouvrir la boîte de dialogue Texte, sélectionnez le cadre de texte, puis sélectionnez Format > 
Texte ou faites un clic droit et choisissez Texte dans le menu contextuel.

Figure 7 : Boîte de dialogue Texte

Les options Adapter la largeur au texte et Adapter la hauteur au texte sont les mêmes que celles 
de la boîte de dialogue Position et taille : voir "Utiliser la boîte de dialogue Position et taille" page 8.

Espacement du cadre
Permet de définir l'espacement du texte par rapport à son cadre.
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Ancrage du texte
Cliquez dans le schéma sur la position à laquelle vous voulez que le texte soit ancré.

Pleine largeur
Ancre le texte sur toute la largeur du cadre.

Vous pouvez également ajouter des effets d'animation (clignotement, défilement, défilement en 
bidirectionnel, défilement puis arrêt) à votre texte en utilisant l'onglet Animation de texte (Figure 8).

Figure 8 : Animation d'un texte

Vous pouvez choisir la direction de l'effet d'animation en cliquant sur l'une des quatre flèches à 
droite. Les propriétés disponibles dépendent de l'effet choisi.

Formater un cadre de texte
Vous pouvez modifier les attributs du cadre de texte lui-même (et non du texte qui se trouve à 
l'intérieur) en utilisant les outils Ligne et Remplissage.
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Supprimer un cadre de texte
Pour supprimer un cadre de texte, sélectionnez-le, puis appuyez sur la touche Suppr.

Il est parfois plus rapide, pour supprimer un cadre de texte, de dessiner un rectangle de sélection 
autour du cadre et d'appuyer sur la touche Suppr. Faites attention dans ce cas à ne pas 
sélectionner et donc supprimer accidentellement d'autres objets.

Associer des textes à des objets Draw

Il est possible d'associer un texte à la plupart des objets Draw. Les exceptions sont les éléments 
de contrôle, comme les boutons ou les listes déroulantes, et les séquences 3D. Un objet n'est pas 
dynamique et ne se comporte pas comme un cadre de texte. Pour conserver un texte à l'intérieur 
des bordures d'un objet, vous devrez utiliser les paragraphes (Entrée), les changements de ligne 
(Maj+Entrée), la réduction de la taille de la police ou l'agrandissement de l'objet, ou une 
combinaison de ces quatre possibilités.

Pour associer un texte à un objet, sélectionnez l'objet. Vous pouvez alors saisir votre texte. Vous 
pouvez également double-cliquer sur l'objet pour faire apparaître le curseur de texte au centre 
(Figure 9).

Figure 9 : Associer du texte à un objet

Vous pouvez utiliser la boîte de dialogue Texte en sélectionnant l'objet, puis en sélectionnant 
Format > Texte ou en faisant un clic droit et en choisissant Texte dans le menu contextuel. Le 
cadre utilisé pour l'ancrage et la définition de l'espacement est celui formé par l'objet.

L'option Renvoyer le texte à la ligne dans la forme fait en sorte que le texte soit le mieux ajusté 
possible à l'intérieur de la forme en ajoutant des retours à la ligne automatiques (Figure 10).

Figure 10 : Option Renvoyer le texte à la ligne dans la forme inactive 
(à gauche) et active (à droite)
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Les options permettant d'adapter la largeur ou la hauteur du cadre au texte ne sont pas 
disponibles. Cependant, l'option Adapter la forme au texte fait en sorte de modifier la taille de 
l'objet pour qu'il comprenne l'intégralité du texte (Figure 11).

Figure 11 : Effet de l'option Adapter la forme au texte

Attention Après l'adaptation de la forme au texte, la modification de la taille de l'objet est 
définitive : si vous décochez l'option, l'objet ne retrouvera pas sa taille initiale. La 
seule façon de le faire est d'annuler l'action d'application des attributs à la forme.

Pour supprimer le texte associé à un objet, vous devez le sélectionner entièrement et le supprimer 
avec la touche Suppr : voir "Sélectionner du texte" page 15.

Insérer du texte

Coller du texte
Un texte peut être inséré dans un cadre de texte ou dans un objet en le copiant dans un autre 
document et en le collant dans votre dessin.

En collant le texte avec l'icône Coller de la barre d'outils Standard, Édition > Coller depuis la 
barre de menus ou un clic droit et le choix de Coller dans le menu contextuel, le texte est collé 
avec son formatage d'origine.

Pour coller un texte avec le format par défaut du paragraphe de destination, cliquez sur le petit 
triangle à droite de l'icône Coller de la barre d'outils Standard et choisissez Texte non formaté 
dans la liste, ou sélectionnez Édition > Collage spécial depuis la barre de menus et choisissez 
Texte non formaté dans la boîte de dialogue Collage spécial qui s'ouvre.

Insérer des caractères spéciaux
Un caractère “spécial” est un caractère qui ne se trouve pas sur un clavier français standard. Par 
exemple, © ¾ æ ø ¢ sont tous des caractères spéciaux. Pour insérer un caractère spécial :

1) Placez le curseur dans le texte où vous voulez que le caractère apparaisse.

2) Choisissez Insertion > Caractères spéciaux, ou faites un clic droit et choisissez 
Caractères spéciaux dans le menu contextuel, pour ouvrir la boîte de dialogue Caractères
spéciaux (Figure 12).

3) Sélectionnez un ou plusieurs caractères (depuis une police ou un sous-ensemble de 
polices) que vous voulez insérer ; puis cliquez sur OK. Les caractères sélectionnés sont 
affichés en bas à gauche de la boîte de dialogue. Quand vous sélectionnez un caractère, il 
est affiché seul à droite, avec son code numérique associé.

Note
Les différentes polices comprennent des caractères spéciaux différents. Si vous 
ne trouvez pas le caractère spécial particulier que vous voulez, essayez de 
changer la sélection de Police.
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Figure 12 : Insérer des caractères spéciaux

Insérer des marques de formatage
Vous pouvez insérer les marques de formatage suivantes :

• Espace insécable

• Tiret insécable

• Tiret conditionnel

Pour ceci, placez le curseur à l'endroit du texte où vous voulez insérer la marque, puis 
sélectionnez Insertion > Marque de formatage depuis la barre de menus et choisissez la marque
que vous souhaitez.

Formater du texte

L'utilisation appropriée du formatage peut donner aux textes de votre dessin un aspect plus 
homogène et professionnel, sans éléments de différenciation pouvant distraire l'attention.

Astuce

Il est parfois très utile de réappliquer le format par défaut du texte sélectionné et 
ainsi de supprimer tout formatage manuel effectué, particulièrement si vous avez 
fait une erreur et n'êtes pas sûr de la façon de l'annuler. Pour revenir au style par 
défaut, sélectionnez la portion de texte concernée et faites Format > Formatage 
par défaut, ou faites un clic droit et choisissez Par défaut dans le menu 
contextuel.
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Sélectionner du texte
Pour formater le texte entier d'un cadre de texte ou d'un objet, sélectionnez tout d'abord le cadre 
ou l'objet, puis effectuez le formatage.

Pour ne formater qu'une portion du texte d'un cadre de texte ou d'un objet, cliquez sur l'icône 
Texte, puis cliquez à l'intérieur du texte. Cliquez et faites glisser pour sélectionner la portion de 
texte désirée : le texte sélectionné apparaît en surbrillance. Vous pouvez aussi utiliser les 
raccourcis clavier suivants :

• Maj et les touches de direction pour étendre votre sélection ;

• Maj+Ctrl et les touches de direction pour étendre votre sélection avec des mots entiers ;

• Maj+Début pour étendre votre sélection jusqu'au début de la ligne ;

• Maj+Fin pour étendre votre sélection jusqu'à la fin de la ligne.

Effectuez alors le formatage.

Utiliser les styles
Les styles d'image de Draw comprennent également les attributs permettant de formater du texte. 
Il est recommandé de les utiliser pour garantir la cohérence des textes de votre dessin et ainsi 
gagner du temps dans leur élaboration.

Pour plus d'informations sur les styles, voir Chapitre 4 (Modifier les attributs d'un objet).

Formater les caractères
Les caractères d'un texte peuvent être formatés indépendamment. Ce formatage vient écraser 
celui du style d'images utilisé. Notez qu'il n'existe pas de style de caractère dans Draw.

Sélectionnez le texte que vous souhaitez. Il existe dans la barre d'outils Formatage du texte un 
certain nombre d'icônes permettant de modifier directement un attribut, comme les icônes Gras ou
Agrandir la police par exemple. Il existe également un certain nombre de commandes dans le 
menu contextuel. Pour accéder à tous les attributs de formatage de caractères, cliquez sur l'icône 

Caractère  de cette barre d'outils, sélectionnez Format > Caractère depuis la barre de menus 
ou faites un clic droit et choisissez Caractère dans le menu contextuel. La boîte de dialogue 
Caractère s'ouvre (Figure 13).

Onglet Police
L'onglet Police permet de choisir la police à utiliser, son style et sa taille. Un aperçu est disponible 
en bas de la fenêtre.

Vous pouvez spécifier la langue utilisée, ce qui est utile pour permettre à plusieurs langues 
d'exister dans un même dessin et d'être vérifiées correctement (orthographe).

Si les options Afficher les éléments d'interface pour les écritures est-asiatiques et Afficher les 
éléments d'interface pour l'écriture bidirectionnelle de Outils > Options > Paramètres 
linguistiques > Langues sont cochées, le contenu de cet onglet sera différent.
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Figure 13 : Onglet Police de la boîte de dialogue Caractère

Onglet Effet de caractères
L'onglet Effet de caractères (Figure 14) offre plus d'options concernant la police.

Figure 14 : Onglet Effet de caractères de la boîte de dialogue Caractère

Couleur de police
Si vous choisissez Automatique, la couleur de la police sera noire.
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Surlignage et soulignage
Vous pouvez choisir parmi plusieurs sortes de surlignage et de soulignage (lignes continues, 
pointillés, tirets courts et longs, dans de multiples combinaisons) et la couleur de la ligne. Vous 
pouvez cocher Mot par mot pour surligner ou souligner les mots individuellement.

Barré
Vous pouvez barrer le contenu avec des lignes, des slash et des X.

Relief
Les possibilités de relief sont : relief (texte surélevé), empreinte (texte enfoncé), contour et 
ombre.

Onglet Position
L'onglet Position (Figure 15) permet de positionner les caractères sélectionnés dans le texte.

Figure 15 : Onglet Position de la boîte de dialogue Caractère

Position
Vous pouvez positionner les caractères sélectionnés au niveau de la ligne (Normal), au-dessus
de la ligne (Exposant) ou au-dessous de la ligne (Indice).

Si vous avez choisi Exposant ou Indice, vous pouvez indiquer la taille relative des caractères 
par rapport à celle de la police. Si Automatique est cochée, Draw va déterminer l'écart par 
rapport à la ligne ; dans le cas contraire, vous pouvez choisir ce pourcentage.

Rotation
L'échelle de largeur vous permet d'indiquer le pourcentage de largeur de police par lequel 
étirer ou comprimer horizontalement les caractères sélectionnés. L'angle de rotation n'est pas 
disponible car le texte ne peut tourné indépendamment de la forme dans laquelle il se trouve.

Espacement
Vous pouvez conserver l'espacement par défaut, étendre ou condenser l'espacement des 
caractères. Dans ces deux derniers cas, vous pouvez indiquer la valeur en points de cet 
espacement.

L'option Paire de crénage permet d'ajuster automatiquement l'espacement des caractères pour
certaines combinaisons de caractères spécifiques.

Formater les paragraphes
Chaque paragraphe du texte peut être formaté indépendamment. Ce formatage vient écraser celui
du style d'images utilisé.

Sélectionnez le ou les paragraphes que vous souhaitez, en totalité ou en partie : positionner le 
curseur dans un paragraphe suffit. Il existe dans la barre d'outils Formatage du texte un certain 
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nombre d'icônes permettant de modifier directement un attribut, comme les icônes Justifier ou 
Interligne : 2 par exemple. Il existe également un certain nombre de commandes dans le menu 
contextuel. Pour accéder à tous les attributs de formatage de paragraphes, cliquez sur l'icône 

Paragraphe  de cette barre d'outils, sélectionnez Format > Paragraphe depuis la barre de 
menus ou faites un clic droit et choisissez Paragraphe dans le menu contextuel. La boîte de 
dialogue Paragraphe s'ouvre (Figure 16).

Onglet Retraits et espacement
L'onglet Retraits et espacement permet de déterminer les retraits et l'espacement du paragraphe. 
Un aperçu est disponible sur la droite de la boîte de dialogue.

Retrait
Vous pouvez modifier le retrait horizontal (l'indentation) des lignes du paragraphe. La valeur 
Avant le texte correspond à la distance entre la marge gauche et le début de la ligne. La valeur
Après le texte correspond à la distance entre la fin de la ligne et la marge droite. La valeur 
Première ligne correspond à la distance supplémentaire entre le début d'une ligne ordinaire et 
le début de la première ligne. Pour mettre en retrait la première ligne d'un paragraphe utilisant 
une numérotation ou des puces, voir "Créer des liste à puces et numérotées" page 21. Toutes 
les valeurs peuvent être négatives.

Espacement
Vous pouvez déterminer un espace vertical que vous allez laisser au-dessus ou au-dessous du
paragraphe.

Interligne
Vous pouvez choisir l'interligne à appliquer entre les lignes du paragraphe :

• Simple : applique un interligne simple.

• 1,5 ligne : applique un interligne d'une ligne et demie.

• Double : applique un interligne de deux lignes.

• Proportionnel : applique un interligne correspondant au pourcentage saisi d'un interligne 
simple.

• Au moins : détermine l'espace minimum d'une interligne, notamment dans le cas où le 
paragraphe comporte des caractères de plusieurs tailles.

• Typographique : applique un interligne typographique de l'espace saisi.

• Fixe : applique un interligne fixe de l'espace saisi.
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Figure 16 : Onglet Retraits et espacement de la boîte de dialogue Paragraphe

Onglet Alignement
L'onglet Alignement (Figure 17) permet de déterminer l'alignement horizontal du paragraphe. Un 
aperçu est disponible sur la droite de la boîte de dialogue.

Figure 17 : Onglet Alignement de la boîte de dialogue Paragraphe
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Onglet Tabulations
L'onglet Tabulations (Figure 18) permet de déterminer les tabulations du paragraphe. La liste 
Position sur la gauche montre toutes les tabulations déjà définies.

Figure 18 : Onglet Tabulations de la boîte de dialogue Paragraphe

Pour ajouter une tabulation, saisissez sa position depuis le début de la ligne, puis indiquez son 
type et son caractère de remplissage. Le bouton Supprimer permet de supprimer la tabulation 
sélectionnée. Le bouton Tout supprimer permet de supprimer toutes les tabulations.

Vous pouvez également ajouter des tabulations en cliquant dans la règle.

Si aucune tabulation n'est définie pour le paragraphe, Draw utilise des tabulations par défaut 
définies par l'espace entre tabulations qui se trouve dans Outils > Options > LibreOffice Draw > 
Général.

Formater du texte 20



Créer des liste à puces et numérotées
Les listes à puces et numérotées peuvent être créées dans des cadres de textes et dans des 
objets. Cependant, si vous créez une liste dans un objet, gardez à l'esprit que cet objet n'est pas 
dynamique et ne va pas s'étendre au fur et à mesure de la création de la liste.

Positionnez le curseur de texte à l'intérieur du paragraphe que vous désirez. Pour créer une liste 

avec le paramétrage par défaut, cliquez sur l'icône (Dés)activer les puces  de la barre d'outils 
Formatage du texte. Pour créer une liste en personnalisant ses paramètres, sélectionnez Format 
> Puces et numérotation depuis la barre de menus, ou faites un clic droit et choisissez Puces et 
numérotation dans le menu contextuel, pour ouvrir la boîte de dialogue Puces et numérotation 
(Figure 19).

Onglet Puces
L'onglet Puces (Figure 19) permet de définir quel caractère associer en tant que puce au 
paragraphe.

Figure 19 : Onglet Puces de la boîte de dialogue Puces et numérotation

Onglet Type de numérotation
L'onglet Type de numérotation (Figure 20) permet de définir quelle type de numérotation associer 
au paragraphe.
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Figure 20 : Onglet Type de numérotation de la boîte de dialogue Puces et 
numérotation

Onglet Images
L'onglet Images (Figure 21) permet de définir quelle image associer en tant que puce au 
paragraphe.

Figure 21 : Onglet Images de la boîte de dialogue Puces et numérotation
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Onglet Position

Attention Pour déterminer le niveau d'un paragraphe dans une liste, vous ne disposez pas, 
comme dans Writer, des outils de la barre d'outils Puces et numérotation. Dans 
Draw, c'est l'insertion d'une tabulation (Tab) au début du paragraphe qui permet de le
descendre d'un niveau.

L'onglet Position (Figure 22) permet de définir la position de la puce ou de la numérotation dans 
chaque niveau de la liste. Un aperçu en bas de l'onglet vous permet de matérialiser les 
modifications que vous voulez effectuer.

Figure 22 : Onglet Position de la boîte de dialogue Puces et numérotation

Vous devez tout d'abord sélectionner, dans la liste Niveau, le niveau dont vous souhaitez modifier 
la position. Vous pouvez sélectionner 1 – 10 pour sélectionner l'ensemble des niveaux.

Retrait
Indique le décalage horizontal entre le début du paragraphe et la puce ou numérotation pour le
niveau sélectionné. Ce paramètre n'est pas disponible si tous le niveaux sont sélectionnés (1 –
10).

L'option Relatif permet d'indiquer si ce retrait est absolu (par rapport au bord gauche du cadre 
de texte ou de l'objet) ou relatif au niveau précédent.

Largeur de la numérotation
Indique l'espace horizontal qu'occupera la puce ou la numérotation pour le niveau sélectionné, 
entre le bord gauche de la numérotation et le bord gauche du texte.

Alignement de la numérotation
Indique comment aligner la numérotation dans la largeur, pour le niveau sélectionné (À 
gauche, Centré ou À droite).

Le bouton Par défaut restaure les retraits et les valeurs d'espacement à leurs valeurs par défaut.
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Onglet Personnaliser
L'onglet Personnaliser (Figure 23) permet de définir le type et les attributs de la puce ou de la 
numérotation dans chaque niveau de la liste. Un aperçu à droite de l'onglet vous permet de 
matérialiser les modifications que vous voulez effectuer.

Figure 23 : Onglet Personnaliser de la boîte de dialogue Puces et numérotation

Vous devez tout d'abord sélectionner, dans la liste Niveau, le niveau dont vous souhaitez modifier 
la position. Vous pouvez sélectionner 1 – 10 pour sélectionner l'ensemble des niveaux.

La liste déroulante Nombre vous permet de choisir le type de puces ou de numérotation pour le 
niveau sélectionné. En fonction de votre choix, les attributs peuvent varier.

Utiliser des tableaux

Les tableaux sont utiles lorsque vous voulez faire figurer des informations structurées dans votre 
dessin, comme une liste de spécifications par exemple. Vous pouvez créer des tableaux 
directement dans Draw, sans avoir besoin d'incorporer une feuille de calcul Calc ou un tableau 
Writer. Les tableaux élaborés avec Draw ont cependant des fonctionnalités limitées.

Créer un tableau
Dans un dessin, les tableaux sont placés à l'intérieur d'un cadre de tableau : ils ne peuvent être 
placés dans un objet ou une forme.

1) Sélectionnez Insertion > Tableau depuis la barre de menus pour ouvrir la boîte de 
dialogue Insérer un tableau (Figure 24).

2) Choisissez le nombre de lignes et de colonnes de votre tableau.

3) Cliquez sur OK pour créer un tableau qui sera placé au centre de votre dessin, dans son 
cadre.
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Figure 24 : Insérer un tableau

Vous pouvez modifier la position du tableau en cliquant et faisant glisser son cadre. Vous pouvez 
modifier sa taille en cliquant et faisant glisser une de ses poignées de sélection. Pour un travail 
plus précis, vous pouvez sélectionner Format > Position et taille depuis la barre de menus, faire 
un clic droit et choisir Position et taille dans le menu contextuel, ou appuyer sur la touche F4. 
Cependant, vous ne pouvez pas faire effectuer une rotation à un tableau.

Modifier un tableau
Lorsqu'un tableau est sélectionné, la barre d'outils Tableau (Figure 25) est alors active. Elle 
apparaît généralement par défaut, parfois à la suite de la barre d'outils Dessin. Dans le cas 
contraire, vous pouvez l'afficher en utilisant Affichage > Barre d'outils > Tableau. Vous pouvez 
également utiliser les outils du menu contextuel.

Figure 25 : Barre d'outils Tableau

Figure 26 : Outils de la barre d'outils Tableau

Tableau
Crée un nouveau tableau dans le dessin en ouvrant la boîte de dialogue Insérer un tableau 
(Figure 24).

Si vous cliquez sur le petit triangle à droite de l'icône, une grille apparaît (Figure 27). Faites 
glisser le pointeur de la souris dans cette grille pour choisir la dimension du tableau et cliquez 
pour le créer. Le bouton Plus vous ramène à la boîte de dialogue Insérer un tableau.
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Figure 27 : Grille pour 
créer un tableau

Style de ligne
Permet de choisir le style de ligne des bordures parmi des styles prédéfinis. Ce style s'applique
aux bordures du tableau ou des cellules sélectionnées.

Couleur de ligne (de la bordure)
Permet de choisir la couleur des lignes des bordures dans la palette de couleurs. Cette couleur
de ligne s'applique aux bordures du tableau ou des cellules sélectionnées.

Bordures
Permet de choisir une configuration de bordure parmi les configurations prédéfinies. Cette 
configuration s'applique aux bordures du tableau ou des cellules sélectionnées.

Vous pouvez définir plus précisément les bordures en utilisant l'onglet Bordures de l'outil 
Propriétés du tableau.

Style de remplissage
Permet de choisir le style de remplissage (Aucun(e), Couleur, Dégradé, Hachure, Bitmap) du 
tableau ou des cellules sélectionnées. La liste déroulante située à droite contient des 
remplissages selon le style choisi.

Fusionner les cellules
Cellule > Fusionner (menu contextuel)

Permet de fusionner les cellules sélectionnées en une seule cellule. Fusionne également le 
contenu de ces cellules : chaque contenu de cellule forme un nouveau paragraphe.

Scinder les cellules
Cellule > Scinder (menu contextuel)

Permet de scinder la ou les cellules sélectionnées en plusieurs cellules en ouvrant la boîte de 
dialogue Scinder les cellules (Figure 28). Le contenu reste dans les cellules d'origine et n'est 
pas scindé.

Utiliser des tableaux 26



Figure 28 : Scinder les cellules d'un tableau

Optimiser
Ligne > Répartir régulièrement (menu contextuel)
Colonne > Répartir régulièrement (menu contextuel)

L'icône Optimiser n'a pas d'autre effet que de faire apparaître deux icônes pour répartir 
régulièrement les lignes et les colonnes.

La répartition régulière des lignes dans le tableau a comme effet que toutes les lignes ont la 
même hauteur, sans que la hauteur globale du tableau ne change.

La répartition régulière des colonnes dans le tableau a comme effet que toutes les colonnes 
ont la même largeur, sans que la largeur globale du tableau ne change.

En haut, Centre (vertical), En bas
Cellule > En haut, Centre, En bas (menu contextuel)

Permet d'aligner verticalement le contenu des cellules sélectionnées.

Insérer une ligne
Ligne > Insérer (menu contextuel)

Permet d'insérer une ligne en-dessous de la ligne où se trouve le curseur de texte. Vous 
pouvez insérer plusieurs lignes à la fois en sélectionnant (totalement ou partiellement) le 
nombre désiré de lignes dans le tableau.

Si vous utilisez le menu contextuel, la boîte de dialogue Insérer des lignes s'ouvre, où vous 
pouvez choisir le nombre de lignes à insérer, et si vous voulez les insérer avant ou après la 
position actuelle.

Insérer une colonne
Colonne > Insérer (menu contextuel)

Permet d'insérer une colonne à droite de la colonne où se trouve le curseur de texte. Vous 
pouvez insérer plusieurs colonnes à la fois en sélectionnant (totalement ou partiellement) le 
nombre désiré de colonnes dans le tableau.

Si vous utilisez le menu contextuel, la boîte de dialogue Insérer des colonnes s'ouvre, où vous 
pouvez choisir le nombre de colonnes à insérer, et si vous voulez les insérer avant ou après la 
position actuelle.

Supprimer la ligne
Ligne > Supprimer (menu contextuel)

Permet de supprimer la ligne où se trouve le curseur de texte. Vous pouvez supprimer 
plusieurs lignes à la fois en les sélectionnant (totalement ou partiellement) dans le tableau.
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Supprimer la colonne
Colonne > Supprimer (menu contextuel)

Permet de supprimer la colonne où se trouve le curseur de texte. Vous pouvez supprimer 
plusieurs colonnes à la fois en les sélectionnant (totalement ou partiellement) dans le tableau.

Sélectionner le tableau
Permet de sélectionner la totalité du tableau où l'on se trouve.

Sélectionner les lignes
Ligne > Sélectionner (menu contextuel)

Permet de sélectionner la totalité de la ligne où se trouve le curseur de texte. Permet 
également de sélectionner la totalité des lignes où se trouvent les cellules sélectionnées.

Sélectionner la colonne
Colonne > Sélectionner (menu contextuel)

Permet de sélectionner la totalité de la colonne où se trouve le curseur de texte. Permet 
également de sélectionner la totalité des colonnes où se trouvent les cellules sélectionnées.

Ébauche de tableau
Permet d'ouvrir la boîte de dialogue Ébauche de tableau (Figure 29), où vous pouvez choisir 
l'apparence du tableau sélectionné.

Figure 29 : Boîte de dialogue Ébauche de tableau

L'option de coloration des lignes et des colonnes permet de faire en sorte que la couleur d'une 
ligne ou d'une colonne sur deux soit plus claire.

Propriétés du tableau
Tableau (menu contextuel)

Permet d'ouvrir la boîte de dialogue Formatage des cellules et de modifier les propriétés des 
cellules sélectionnées.

Les propriétés des onglets Police et Effets de caractères s'appliquent au texte contenu dans 
les cellules sélectionnées et sont identiques à ceux de la boîte de dialogue Caractère (Figure 
13 et Figure 14).
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Figure 30 : Onglet Bordures de la boîte de dialogue Formatage des cellules

L'onglet Bordures permet de définir plus précisément les bordures du tableau.

Vous pouvez choisir une disposition des lignes par défaut ou cliquer dans l'aperçu pour définir 
votre propre style de bordure. Vous pouvez cliquer sur chacune des lignes de côté et chacune 
des lignes diagonales. Cliquez successivement sur une ligne pour ajouter une bordure 
(apparence du trait), conserver la bordure existante (trait en grisé) ou supprimer une bordure 
(vide).

Vous pouvez choisir le style, la largeur et la couleur de la ligne de bordure.

Vous pouvez indiquer l'espace que vous voulez laisser entre la bordure d'une cellule et son 
contenu. L'option Synchroniser permet d'appliquer le même espacement des quatre côtés de 
la cellule.

Si vous avez sélectionné une plage de cellules, et non pas une cellule individuelle, vous 
pouvez distinguer les bordures de la plage de cellules des bordures de chaque cellule 
individuelle.

L'onglet Arrière-plan est identique à l'onglet Remplissage de la boîte de dialogue 
Remplissage : voir Chapitre 4 (Modifier les attributs d'un objet).

Supprimer un tableau
Pour supprimer un tableau, sélectionnez-le en cliquant sur un de ses côtés et appuyez sur la 
touche Suppr.
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Utiliser des champs

Les champs permettent l'insertion automatique de texte dans un dessin. Leur valeur est calculée 
lorsque le document est chargé ou imprimé et le résultat s'inscrit dans le dessin.

Insérer un champ
Pour insérer un champ dans le dessin, sélectionnez Insertion > Champs depuis la barre de 
menus, puis choisissez le champ que vous désirez. Un cadre de texte contenant le champ est créé
au milieu du document.

Vous pouvez également positionner le curseur de texte où vous le souhaitez, puis utiliser Insertion
> Champs. Le champ sera alors inséré à cet endroit.

Champs
Les champs disponibles dans Draw sont :

• Date (fixe) : insère un champ contenant la date au moment de l'insertion du champ.

• Date (variable) : insère un champ qui se met à jour avec la date lors de l'ouverture du 
document.

• Heure (fixe) : insère un champ contenant l'heure au moment de l'insertion du champ.

• Heure (variable) : insère un champ qui se met à jour avec l'heure lors de l'ouverture du 
document.

• Auteur : insère un champ contenant l'auteur du document. Cette information provient de 
Outils > Options > LibreOffice > Données d'identité.

• Numéro de page : insère un champ contenant le numéro de la page (diapositive) en 
cours.

• Nombre de pages : insère un champ contenant le nombre total de pages (diapositives) du 
document.

• Nom de fichier : insère un champ contenant le nom du document.

Personnaliser un champ
Vous pouvez personnaliser le contenu d'un champ en plaçant le curseur de texte au début de ce 
champ et en sélectionnant Édition > Champs depuis la barre de menus. La boîte de dialogue 
Éditer le champ s'ouvre (Figure 31).

Les formats disponibles dépendent du champ sélectionné.

Il n'est pas possible de personnaliser les champs Numéro de page et Nombre de pages.
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Figure 31 : Éditer un champ

Vous pouvez également personnaliser un champ en faisant un clic droit : le contenu du menu 
contextuel est équivalent à celui de la boîte de dialogue Éditer le champ.

Utiliser des hyperliens

Les hyperliens peuvent être utilisés dans Draw pour basculer vers un nouvel endroit dans le 
document, ou peuvent mener à d'autres fichiers ou des sites web.

Pour insérer un hyperlien dans le dessin, sélectionnez Insertion > Hyperlien depuis la barre de 
menus. La boîte de dialogue Hyperlien s'ouvre. Saisissez les attributs, cliquez sur Appliquer et un 
cadre de texte contenant l'hyperlien est créé au milieu du document.

Vous pouvez également positionner le curseur de texte où vous le souhaitez, puis utiliser Insertion
> Hyperlien. L'hyperlien sera alors inséré à cet endroit.

Pour plus d'informations sur la définition des hyperliens, voir Chapitre 10 (Lier les données de 
Calc) du Guide Calc.
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